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In April, | talked about Photoshop Elements 3.0 Organizer. This new edition to a terrific
image editing, management and creation tool from Adobe deserves two workshops.
Remember, PhotoShop & Image Editing SIG on the 4™ Tuesday of each month at 4:00 pm
at the Resource Center. We can discuss all your questions and ideas and solutions.

Regardless of which edit mode you use, one of the most important things to learn about is
the file format. This determines the type of file your image becomes. You can either save in a
.psd, .jpg or any of a number of file types at this point. If you use the .psd format (which is the
PhotoShop default), you will be able to return to the image and make changes in the future.
.psd will maintain the layers you create during editing. Once you are ready for output, you
may also want to save the image as a .jpg or other format to suit your needs. When you save
an image after an edit, you have the option of saving it as a new file instead of overwriting the
original image.

Auto Fix
The Auto Fix window will allow you to crop and offers a selection of presets or allows you to
define your own size. General Editing allows for Auto Smart Fix, Auto Levels, Auto Contrast,
Auto Sharpen. You can easily reset the image if these adjustments don’t suit you.
. from the Organizer window, SLC on the image you want to edit
. SLC on Edit on the Button Bar or Menu Bar
. SLC on Auto Fix Window
At this point you can crop and auto enhance your image. | usually enhance the image first
and then do a crop as needed.

> SLC on Auto Smart Fix to effect levels, contrast, sharpness

> SLC on Auto Levels, Auto Contrast or Auto Sharpen to effect just one
enhancement

> SLC on Reset Image at the bottom of the panel

> SLC on More Editing will take you into the Standard Edit Mode for more
options

> along the bottom panel are the Rotate, Full/Zoom View and Zoom Slide

> SLC on the Crop button at the top right to crop to a variety of preset
photo print sizes or a square. You are limited to the presets in this mode.

Quick Fix
The Quick Fix mode gives you a little more control over the changes you can make. Adjust
the amount of the Smart Fix, Levels, Contrast, Color and Sharpening. You can zoom in
andout, crop, and use the red-eye removal tool if needed.
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from the Organizer window, SLC on the image you want to edit

. SLC on Edit on the Button Bar or Menu Bar

. SLC on Go to Quick Fix ...

In the Quick Fix mode, look to the left-hand column to see the Zoom, Move, Crop and
Remove Red Eye tools. Along the top of the workspace is the options bar for each of the
tools. Along the bottom of the workspace you will see a View options box. Below that, if you
are editing more than one image at a time, you can use the Photo Bin.

To the right of the workspace are the “fixes”
General Fixes

>

>

>

Choose to rotate the image if needed.
Select Auto - Smart Fix
Use the slider to select the degree of “fix”

Lighting

>

Choose Auto Levels

Choose Auto Contrast

or

Select your own settings for Shadows, Highlights (Levels) & Midtones
(Contrast)

Select Auto Color

or make changes to

Saturation - The purity, or strength, of a color. Also called chroma. A fully
saturated color contains no gray. Saturation controls make colors more vivid
(less black or white added) or more muted (more black or white added).
Hue - The color reflected from or transmitted through an object. In common
use, hue is the property that allows a color to be distinguished as red, blue,
yellow, and so on; the “color of a color.”

Temperature - The position of a color along a continuum from warm (red) to
cool (blue)

Tint - A variation of a color produced by adding white, thus decreasing
saturation and increasing lightness.

Sharpness

>

The Sharpen filters focus blurry images by increasing the contrast of
adjacent pixels.

Click Auto Sharpen to use the default amount of sharpening. Drag the
slider to vary the amount of sharpening. Zoom your preview to 100% to
get a more accurate view of the amount of sharpening you are applying.

You can always reset the image to it’s original state if you're not sure of the change and need
to start over. Auto Fix or Quick Fix may work for most of your editing needs. If you need a
little more detail in the changes you make, you may wish to go to Standard Edit.
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Standard Edit
Standard Edit can be reached from the Organizer by a click on Edit/Go to Standard Edit ... or
by pressing the key combination Ctrl + |. When your window opens you will have a view of
your image in the workspace. When an image is being edited, the Organizer will show you
“Edit in Progress”. The Toolbar is setup on the left side of the workspace with the tool options
bar running along the top below the Menu & Button bars.

New tools include the Healing Brush, Cookie Cutter shapes, many automatic correction tools,

support for digital camera raw data files. The Red Eye Reduction too has been improved.

The toolbar has been reduced to one column. Get to know your tool bar. PSE3 has a

redesigned the tool bar. A good view of this is available at
http://arraich.com/elements/ref2/aatoolbarV3.htm.

This is a terrific website for anyone interested in learning more about Adobe Photoshop Ver

7, Elements 2 or 3 and more. Take the time to visit Jay’s site.

At the bottom of the workspace is the Photo Bin. If you are working with more than one
image, you can easily switch between images via the Photo Bin.

In the right-hand column is the Palette Well. These tools expand and collapse as needed by
a click on the white arrow at the left of each header. The How To, Styles & Effects and the
Layers palettes are there by default. | usually work with Layers, Undo History & Navigator
palettes open. Click on Window in the Menu bar to access these two additional palettes. I've
found this the best setup for most editing | do.

Layers are a most important tool for working with your images. You can do a lot of changes
to the “background” layer, but not all changes work. You will note the layer is generally called
“packground”. Using layers allows you to isolate and enhance, replace or remove certain
areas of an image.

To add a new layer
> SLC on Layer
> SLC on Duplicate Layer

> When the Layer dialog box opens, just click OK or give it a name.
or
> “‘drag” the background layer to the new layer icon in the palette (small icons just

above the layer)
Remember, in PSE3.0 you can hover over a button and wait for the tool tip to pop up and
remind you what it is.

Take the time to play around with each of the tools. Open an image. Save it as a new file
(with a different file name such as “practice.psd”). You will eventually set your own “rhythm”
in the way you work with the tool palette, tool options bar, layers, enhancements and effects.


http://arraich.com/elements/ref2/aatoolbarV3.htm
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Generally, my rhythm goes something like this.

>

When the image first opens, | immediately save it as a new file with a new

automation to this function.

name to protect the original image. If working from the Organizer, there will be some E

>

>

| generally save as a .psd for flexibility in future changes to the image.
Create a duplicate layer to work on so the lock on the background layer doesn't
interfere with changes.
Check my Background & Foreground colors. If I'm working on a photo, | often
reset the colors to black & white by clicking on the color palette reset button at
the bottom of the tool bar.
Depending on the ultimate use of the image | resize the image. One of
the most important functions is the ability to RESIZE your images.
Whether you need to save the image in print quality or reduce the size of
the file to send it in an e-mail or change the resolution,
¢ SLC on Image/Resize. Note the Pixel Dimensions of the

image (especially digital camera files. (9.00M means a 9

megabyte file)
¢ A too large file will not go over the internet easily. If you are

going to create a slide show, VCD or web gallery, you will

need to resize all images to the same size and resolution

so they will all relate to each other.
SAVE THE IMAGE (either Ctrl+S, SLC on the Save icon or Alt+File/Save)
Then | begin the enhancement process. Enhance in the Menu Bar allows the
following. Auto Smart Fix, Auto Levels, Auto Contrast, Auto Color Correction or
you can keep more control of changes by using Adjust Smart Fix, Adjust
Lighting, Adjust Color. Again, use your practice image to make changes to see
how each of these adjustments work.
The ability to Enhance the image uses Automatic settings or allows you to
adjust as you like manually. You can SLC on Enhance/Adjust Lighting/Levels
(Ctrl+L) to access one of the most powerful manual adjustments in PSES3.
Levels opens a dialog box which allows you to “slide” the markers for highlights,
midtones and shadows until you get the brightness and contrast as you like.
This is more powerful than using just the Brightness or Contrast or even the
Shadows and Highlights but you may like how those functions work.
SAVE THE IMAGE
If you need to punch up an area, or blur a background, or cut something out
entirely, use the Selection menu and the Selection Tools. These include the
Rectangular & Elliptical Marquee Tools, the Standard, Magnetic & Polygonal
Lasso Tools, the Magic Wand and the Selection Brush tool. Each does a
specific selection process depending on your needs. My favorite combination is
using the magic wand and the selection brush to get exactly what | want to
select. You can also make some interest effects by feathering the selection. If
you have a selection to repeat in multiple areas or different images or to later
use in a mask effect, you can save, load or delete a selection.
SAVE THE IMAGE
The Filter effects include Artistic, Brush Strokes, Distort, Sketch, Stylize, &
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Texture among others. These are accessible either from the Menu list or from
the Filter Gallery. Use your practice.psd to experiment with different effects.
> SAVE THE IMAGE
Creations
Each of these creations can be accessed from your Organizer. To access Creations do one
of the following:

. In the Photo Browser, choose File > New> (creation).
. In the Editor, choose File > New > Creation. Select your choice and click OK.
. Click the Create button in the Organizer. Select your choice and click OK. You can

use your Organizer to select, group or tag the images you want to include. You are
also able to add or remove images once you have started each creation wizard.

Slide Show

There are two modes for Slide Show creation - Custom or Simple. Simple may be all you

need. PSE3 will take your creation and save it as a PDF file which can be read on any

system which has Adobe Acrobat Reader on it. (You may need to update your version.)
Simple Slide Show

> Your images will be displayed. You can drag them to reorder them as needed.

> Slide Show Options allow you to choose the type of transition, duration of
transition, looping, & viewing upon saving

> Photo Options allow you to size the images to your viewing screen as well as

picking the output quality of the images.
Once all choices have been made, SLC on Save and select the location for the .pdf file to be
saved.
Custom Slide Show

> Your 1% image will appear in the main workspace with the remaining images in
a film strip below.

> Both the Menu bar and the Button bar give access to various functions. You
can add more images, add music, and even add a voice recorded narration.

> You can reorder the slides by dragging them to the place you want them.

> You can create Title slides in Edit mode and add them as well.

> Preview the slide show by using the play/stop/pause controls below the main
image.

> You can change the duration of the image as well as the duration of the
transition between images.

> When you add music you can have the slides change to the beat of the music

by using Fit Slides to Audio
Remember that 5 seconds can be a long, long time to view a slide. Try 3 or 4 seconds with a
1 or 2 second transition time. If you want to fit slides to your audio, these times will be
changed.

Create VCD with Menu

If you are interested in view your slide shows on your TV through your DVD player, PSE3 has
a wizard to help you do this. You MUST first create your slide shows and export them or save
them in a WMV (windows media/video) format.
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> Be sure that all your custom slide shows are saved and are now in your
organizer. When you are ready to save the slide show, choose the option
Output as WMV. Then be sure that your organizer “sees” it.

> Most wmv files want to be saved to the My Videos folder in My Documents. |t
will take quite some time to save a wmv file depending on the number of slides.

Photo Books & Album Pages
> Step 1, Select a Style, Select your options (title, captions, page numbers,
photos per page) SLC on Next Step.
> Step 2, Arrange your photos by dragging them into position, SLC Next Step

> Step 3, View each page, add text as needed. You can change the font style,
size and color. SLC Next Step

> Step 4, Save - be sure to check Show these photos in my Photo Browser when
finished to add to the organizer.

> Step 5, Share allows you to determine saving the book, printing the book or

sharing the book via e-mail.
Be sure to click Done when complete to return to your Organizer.

Greeting Cards
> Step 1, Select the Style of you card
> Step 2, If you are using multiple images, this is where you arrange them.
> Step 3, Create the text on the front and inside of the card
> Step 4, Save ( be sure to remember to have it show the photos in the
organizer) SLC on Save to complete this step.
> Step 5, Share allows you to save as a PDF, e-mail or print the card.
Be sure to click Done when complete to return to your Organizer

Photo Card
Basically the same as photo books & greeting cards as far as creation, but you can also
order the photo cards printed via online.

Wall Calendar
Select all 13 photos you wish to use in your calendar then SLC on Create/Calendar
> Step 1, Choose layout & dates
> Step 2, Arrange the photos in the order you wish them to appear
> Step 3, Customize by including your own titles & captions
> Step 4, Save
> Step 5, Share
Be sure to click Done when complete to return to your Organizer.

Web Gallery

The web gallery wizard will open. Your images will be displayed on the left. You can drag
them to reorder them. Choose a style from the Gallery Style menu. A preview of the home
page for the chosen style appears below the list. At the bottom, type a name in the Site
Folder text box for the folder that will contain your gallery files. When you're done creating
the web photo gallery, you'll copy these files to a web server. If necessary, click Browse and
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select the location where you want to save the web photo gallery files. Anyone wanting more
info on this process, please come to the PSE/Image Editing SIG.

After thoughts ... thanx again to all who joined us at the workshop. Please e-mail me with
question or come to the PSE3 SIG every fourth Tuesday from 4:00 to 6:00 at the Resource
Center. | know | could have gone on for another hour, but time . . . and questions caught us.
I'll be happy to work with members and the folks from SHARE if you need help with Adobe
Photoshop Elements 3.0.

Also, from time to time, I'll add to my gallery of graphics, images, photos & web pages done
with Photoshop at http://hhicomputerhelp.com & http://jolyn.org



http://hhicomputerhelp.com
http://jolyn.org
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Web Gallery

The web gallery wizard will open. Your images will be displayed on the left. You can drag them to
reorder them. Choose a style from the Gallery Style menu. A preview of the home page for the chosen
style appears below the list. At the bottom, type a name in the Site Folder text box for the folder that
will contain your gallery files. When you’re done creating the web photo gallery, you’ll copy these files
to a web server. If necessary, click Browse and select the location where you want to save the web

photo gallery files. Anyone wanting more info on this process, please come to the PSE/Image Editing
SIG.

To set up the title banner in your web photo gallery, click the Banner tab. Then set any of the
following options:

> Title. Specifies the name for your gallery. It appears on your web page and in the
browser’s title bar.

> Subtitle. Specifies a subtitle in your gallery. Depending on the template, the subtitle
may appear in the footer, the header, or not at all.

> E-mail Address. Specifies the e-mail address if you want one to appear in your web
photo gallery. In some templates, the e-mail address does not appear.

> Font and Size. Sets the font and size options. These options are not available for all
gallery styles.

To set up the thumbnails in your web photo gallery, click the Thumbnails tab. Then set the
following options:
> Thumbnail Size. Defines the size of thumbnails.
> Font and Size. Specifies the font face and font size to use with any file name, caption,
or date information displayed with the thumbnails. These options are not available for
all gallery styles.
> Use Filename, Caption, or Date. Specifies what information to include with thumbnails.
Note: If you select the Use Caption option, make sure that your photos
have captions, or nothing will appear under the thumbnails.

To set up the full-size photos in your web photo gallery, click the Large Photos tab. Then set

the following options:

> Resize Photos. Resizes the photos for the gallery pages. Choose X-Large if you aren't
concerned about download speed for viewers of your Web pages and want the photos
to fill the screen as much as possible. Use the smaller sizes if you want the pages to
load more quickly over a slow connection. If you want viewers to see your
full-resolution photos, do not select Resize Photos. Remember, though, that photos
over 1-megapixel resolution are larger than the screen resolution for most viewers and
can take a long time to download.

> Photo Quality. Designates the quality level for your photos. Keep in mind that better
image quality also means a larger file size and longer download times to view.
> Font and Size. Specifies the font face and font size to use with any file name, caption,

or date information displayed with the large photos. These options are not available
for all gallery styles.
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> Use Filename, Caption, or Date. Specifies what information to include with the large
gallery photos.
Note: If you select the Use Caption option, make sure that your photos have
captions, or nothing will appear under them.

To color elements in the gallery, click the Custom Colors tab. To change the color of a
particular element, click its color swatch, and then select a new color using the Color Picker.
For example, to change the background color of each page, click the Background swatch; to
change the background color of the text banner, click the banner swatch.

Click Save to create the gallery and preview it in the Web Photo Gallery Browser window.
The application places the following HTML and JPEG files in your destination folder:

¢ JPEG images inside the Images subfolder

¢ HTML pages inside the Pages subfolder

¢ JPEG thumbnail images inside the Thumbnails subfolder

¢ Index HTML file for the home page of your Web gallery

Copy the contents of the destination folder to a web server. For information on how and
where to transfer the files, contact your Internet service provider..
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